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n Software Edition Overview

Read Naturally's pioneering programs offer a proven strategy to help struggling readers
improve their fluency and comprehension. This chapter provides an overview

of Read Naturally Software Edition (SE) version 2.0, the software version of our
reading strategy.

This chapter includes the following information:

m  The system requirements for the software (workstation and server requirements).

®  The components of Read Naturally SE—Teacher Management and Student Stories.
®  The two types of installations—stand-alone and network.

® A summary of the new features in this version of Read Naturally SE.

m  How to start and exit Read Naturally SE.

m  Ways you can get assistance when you have questions about or problems with
Read Naturally SE:

—  Check the manuals.

—  Check the online help.

— Check the Read Naturally website.
— Contact Read Naturally.

Copyright © 2004—2006 Read Naturally, Inc. 1 Software Edition Overview
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System Requirements

To use Read Naturally SE, your system must meet the following minimum
requirements:

Workstation Requirements

Windows

Windows 98SE*, ME* NT, 2000, or
XP

350 MHz or faster processor
256 MB RAM

100 MB hard disk space
800 x 600 screen resolution
CD-ROM drive

Windows Media Player 6.1 or higher,
or QuickTime 6 or higher

Adobe Flash Player 6 or higher

Macintosh

m  Mac OS 9.2* or OS X 10.2 or higher
m 350 MHz or faster processor

m 256 MB RAM

m 100 MB hard disk space

m 800 x 600 screen resolution

m  CD-ROM drive

B QuickTime 6 or higher

m  Adobe Flash Player 6 or higher

*Supported only for stand-alone or workstation installations. See below for server
requirements.

Server Requirements for Network Installations

®  One of the following operating systems:

Windows NT
Windows 2000
Windows XP
Windows Server 2000
Windows Server 2003

Mac OS X or Mac OS X Server 10.2 or higher
(Read Naturally recommends upgrading to the latest version available.)

m 512 MB RAM
® 40 MB disk space (minimum), 100 MB recommended
® 100 MB disk space for each story level
®  CD-ROM drive
m  TCP/IP network
m  Static [P address
Software Edition Overview 2
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Components of Read Naturally SE

Read Naturally SE (Software Edition) provides the same powerful strategy and the same
high-interest stories as Read Naturally ME (Masters Edition) but in a software version.
SE eliminates the need for cassettes or audio CDs, cassette or CD players, timers,
reading guides, pencils, graphs, and duplicating blackline masters.

Read Naturally SE consists of two components. The software is available for both
Windows and Macintosh operating systems.

CETL T ERELIGERIE Teachers use this component to manage student, teacher,
and class information, specify student story options, place
students in the appropriate level, and print awards and
letters. A powerful reporting feature lets you track and
analyze results for individual students and groups of
students.

Student Stories Students use this component when working with stories in
their reading levels. Student Stories automatically leads the
students through the steps of the Read Naturally strategy.

Stand-Alone vs. Network Installation

You can run the software locally on individual computers (stand-alone installation) or
from a server in a local area network environment (network installation).

Stand-Alone Installation

With a stand-alone installation, you run SE from each computer's hard drive. Student,
teacher, and class data is stored locally on that computer. When students read the stories,
the CD containing the stories for their level must be in the computer's CD drive. Since
the students' data is stored locally on the computer they are using, they must always use
the same computer in order to keep their results data in one place.

Network Installation

With a network installation, the stories as well as student, teacher, and class data

are stored on the server. The SE applications are installed on client workstations

that have access to the network server. This makes it possible for students, teachers,
and administrators to work from any workstation that has SE installed and can access
the server.

Copyright © 2004—2006 Read Naturally, Inc. 3 Software Edition Overview
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New Features in SE Version 2.0

The new version 2.0 of Read Naturally SE includes many enhancements and new
features, including:

®  Native compatibility with Mac OS X, as well as continued support for Mac OS 9
and Windows 98SE through XP.

m  Sequenced level 8.0 and phonics level 2.3 in software format.

® A new key words step with definitions and pictures.

m  Ability to click difficult words in the Cold Timing and Practice steps to have them
highlighted and spoken.

®  Ability to click vocabulary words during the Read Along and Quiz steps to have
them defined.

m  Greater teacher control. Teachers can:
— Select 1-minute, 2-minute, or whole-story timings.
— Select which steps to include for each student.
— Select whether the teacher must be present for cold timing.
— Use enhanced print options.
— Have more control over pass requirements.

®  [mproved management system featuring:
— Enhanced reporting with bar and line graphs.
— Automatic tracking of student, class, and teacher information.

®  An import utility for importing data from SE 1.x.

Software Edition Overview 4 Copyright © 2004—2006 Read Naturally, Inc.
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Starting and Exiting Read Naturally SE

You can start either Teacher Management or Student Stories by double-clicking the
same Read Naturally icon. This icon is placed on the Windows or Macintosh desktop
when the software is installed and is also located in the Read Naturally SE folder. The
password you enter when you log in determines whether Teacher Management

or Student Stories starts.

To start Read Naturally SE:

1 Double-click the Read Naturally SE 2.0 icon on your desktop.
The log-in screen displays.

2 Type your password and click Enter.
m [f you enter a teacher or administrator password, Teacher Management starts.

m [fyou enter a student password, Student Stories starts.

Note: For stand-alone installations, you must insert the appropriate level CD in the
computer's CD-ROM drive before you log in as a student.

m  The first time you log in, enter the special password rnse to start Teacher
Management. This password is intended for one-time use only and no longer
works once you create an administrator password.

Copyright © 2004—2006 Read Naturally, Inc. 5 Software Edition Overview
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To exit Read Naturally SE:

1 From either Teacher Management or Student Stories, click Quit (choose Quit from
the File menu). This returns you to the log-in screen.

2 From the log-in screen, you can:
m  Click Exit to exit Read Naturally SE completely.
®  Log in with a teacher or administrator password to Teacher Management.

m  Log in with a student password to Student Stories.

Software Edition Overview 6 Copyright © 2004—2006 Read Naturally, Inc.
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Getting Assistance When You Have Questions or Problems

If you have questions or problems while using Read Naturally SE, you have the
following options for getting assistance.

®  Check the manuals (SE Teacher's Guide and SE Software Guide).
®  Check the online help (Teacher Management and Student Stories).
®  Check the Read Naturally website.

®  Contact Read Naturally.

Check the Manuals

The manuals that ship with Read Naturally SE contain in-depth information for setting
up and using the software.

®  The SE Teacher's Guide is written from a teacher's perspective and includes
extensive information for setting up and using the software with students.

®  The SE Software Guide contains information about installing the software, setting it
up for the first time, and administering the information in SE.

m  The SE Answer Guide lists the answers to the open-ended quiz questions. Teachers
and their assistants can use this guide to check students' answers.

The SE Teachers Guide and SE Software Guide include key word indexes to help you
find specific information quickly.

Check the Online Help

SE Teacher Management and Student Stories both include online help that you can
browse or search to find answers to your questions. Much of the information is similar
to the topics in the SE Teacher's Guide and SE Software Guide.

To view the online help in either Teacher Management or Student Stories, select Online
Help from the Help menu. The help opens in a separate window. From this window, you
can locate information using the Contents and Search tabs.

(o NEHICHETM Allows you to locate help topics by browsing through a list of the
topics available. This option is equivalent to a book's table of
contents.

Search Tab Provides full-text search capabilities. To search, enter a word or
phrase and then either click the Find button or press the Enter key.
The search locates all occurrences of the word or phrase throughout
the help system and displays a list of help topics found.

Copyright © 2004—2006 Read Naturally, Inc. 7 Software Edition Overview
SE Software Guide



Check the Read Naturally Website

If you have problems using Read Naturally SE, check the support section of the Read
Naturally website:

www.readnaturally.com/support/

The support pages include frequently asked questions, knowledgebases, troubleshooting
information, electronic files of the manuals, and more.

Other pages on the website contain background information about the Read Naturally
strategy, case studies illustrating the effectiveness of the strategy, and information about
Read Naturally products and seminars.

Contact Read Naturally

You can contact Read Naturally with questions, problems, or to order additional
products.

(o111 RSl 2T www.readnaturally.com/support/supportRequest.htm
Support Request

Telephone 651.452.4085 or 800.788.4085

651.452.9204

SOEUWCICEERId info@readnaturally.com
General Issues

www.readnaturally.com

Office Hours Monday through Friday
9:00 a.m. to 5:00 p.m. Central Time

Software Edition Overview 8 Copyright © 2004—2006 Read Naturally, Inc.
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E Windows Stand-Alone Installation

This chapter explains how to install Read Naturally SE 2.0 software on Windows stand-
alone PCs. During the installation process, you perform the following tasks:

1 Read the license agreement.

2 Specify the location where the software will be installed.

3 Copy the files to the PC's hard drive.

4 Enter license numbers for the levels you purchased.

5 Start setting up your school, teacher, class, and student data.

This chapter also includes a procedure for adding levels when Read Naturally SE is
already installed.

Copyright © 2004—2006 Read Naturally, Inc. 9 Windows Stand-Alone Installation
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What's Installed

When you install the Windows stand-alone software, the installer creates a Read
Naturally SE 2 folder in the Program Files folder on your computer's hard drive
and copies the following files to it:

Application Files

m  The Teacher Management component
®  The Student Stories component

®m A placement program

®  Reporting software

®  Online help files

®  Other supporting programs and files

Data Files

m  Database files for storing teacher, class, and student information
®  Audio files for the stories

m  Text and image files for the placement program

All of these files are installed automatically during the installation process. For stand-
alone installations, the actual stories themselves are not installed on the computer's hard
drive. The CD for the level a student is working on must be in the computer's CD drive
when he or she is using Student Stories.

Windows Stand-Alone Installation 10 Copyright © 2004—2006 Read Naturally, Inc.
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Installing the Windows Stand-Alone Software

Before you begin, you should close all other applications, especially virus-protection
software, which can interfere with the installation process.

To install SE stand-alone software on a Windows workstation:

1 Insert the Stand-Alone Software Installation CD into the computer's CD drive.

2 If a menu for installing SE 2.0 does not open automatically, double-click My
Computer on the desktop, double-click the RNSE2 Install_SA icon for the CD
drive, and then double-click Menu_Win.exe.

3 Click Install Windows Software. The initial setup screen displays.

4 Click Next. The Welcome screen displays.

5 Click Next. The Software License Agreement displays.

Copyright © 2004—2006 Read Naturally, Inc. 11 Windows Stand-Alone Installation
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6 Click Yes to accept the terms of the license agreement. (You must accept the terms
in order to install the Read Naturally software.) The Choose Destination Location
screen displays.

7 By default, Read Naturally SE is installed in the Program Files folder of your hard
drive (C:). In most cases, you should leave the installation location set to the
default. If you need to change the location, click Browse, choose the folder where
you want to install the Read Naturally software, and then click OK.

8 Click Next. The Ready to Install screen displays.

Windows Stand-Alone Installation 12 Copyright © 2004—2006 Read Naturally, Inc.
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9 Click Next. Read Naturally SE is installed on your computer. When installation is
complete, the Level Registration screen displays.

10 In the Level Registration window, enter the license numbers for the levels you
purchased. For each license, enter the two-part license number in the boxes and
click Add License. The licenses are added to the list.

11 After you have added all of your licenses, click Next. The Installation Complete
screen displays.

Copyright © 2004—2006 Read Naturally, Inc. 13 Windows Stand-Alone Installation
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12 Click Done. The Finished screen displays.

13 You can either start setting up teachers, classes, and students right away or do it
later.

m  To start setting up your data right away, leave the check box checked and click
Close. The Read Naturally login screen displays.

m  To set up your data later, uncheck the box and click Close.

For information about setting up your data, see Chapter 6.

Windows Stand-Alone Installation 14 Copyright © 2004—2006 Read Naturally, Inc.
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Adding Levels for Windows Stand-Alone Installations

If you have already installed Read Naturally SE but you need to add levels (for
example, you may have purchased more levels), you can add the new levels without
having to re-install the software.

To add levels for a Windows stand-alone installation:
1 Log in to Read Naturally SE with the administrator password.

2 Choose the School tab.

3 From the File menu, choose Register Levels. The Level Registration window
displays.

4 Enter the license numbers for the levels you are adding. For each license, enter the
two-part license number in the boxes and click Add License. The licenses are added
to the table.

5 After you have added all of your licenses, click Next. The Installation Complete
screen displays.

6 To add more levels, click Back and repeat steps 4 and 5. If you are finished adding
levels, click Done.

Copyright © 2004—2006 Read Naturally, Inc. 15 Windows Stand-Alone Installation
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B Macintosh Stand-Alone Installation

This chapter explains how to install Read Naturally SE 2.0 software on Macintosh
stand-alone computers. During the installation process, you perform the following tasks:

1 Read the license agreement.

2 Copy the files to the computer's hard drive.

3 Enter license numbers for the levels you purchased.

4 Start setting up your school, teacher, class, and student data.

This chapter also includes a procedure for adding levels when Read Naturally SE is
already installed.

Copyright © 2004—2006 Read Naturally, Inc. 17 Macintosh Stand-Alone Installation
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What's Installed

When you install the Macintosh stand-alone software, the installer creates a Read
Naturally SE 2 folder in the Applications or Applications (Mac OS 9) folder on your
computer's hard drive and copies the following files to it:

Application Files

m  The Teacher Management component
®  The Student Stories component

®m A placement program

®  Reporting software

®  Online help files

®  Other supporting programs and files

Data Files

m  Database files for storing teacher, class, and student information
®  Audio files for the stories

m  Text and image files for the placement program

All of these files are installed automatically during the installation process. For stand-
alone installations, the actual stories themselves are not installed on the computer's hard
drive. The CD for the level a student is working on must be in the computer's CD drive
when he or she is using Student Stories.

Macintosh Stand-Alone Installation 18 Copyright © 2004—2006 Read Naturally, Inc.
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Installing the Macintosh Stand-Alone Software

Before you begin, you should close all other applications, especially virus-protection
software, which can interfere with the installation process.

To install the SE stand-alone software on a Macintosh workstation:

1 Insert the Stand-Alone Software Installation CD into the computer's CD drive.

2 When the CD icon RNSE2_Install_SA appears on the desktop, double-click it. A
window opens showing the contents of the CD.

3 To open the Mac OS installation menu, double-click either Menu_OSX if you use
Mac OS X or Menu_OS?9 if you use Mac OS 9.

4 From the installation menu, click either Install Mac OS X Software or Install Mac
OS 9 Software, depending upon the Mac OS version you are using.

5 If necessary, enter your Mac OS administrator name and password and click OK so
that you are allowed to install the software. The Introduction screen displays.

6 Click Continue. The Software License Agreement displays.

Copyright © 2004—2006 Read Naturally, Inc. 19 Macintosh Stand-Alone Installation
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7  You must accept the terms of the license agreement in order to install the Read
Naturally software.

B In Mac OS 9, click Agree.

B In Mac OS X, click Continue. A dialog asks if you agree to the terms of the
license agreement. Click Agree.

The Installation Type screen displays.

8 Leave the installation type as Easy Install and click Continue (Mac OS X) or
Install (Mac OS 9). The installation process begins. Installation could take several
minutes as the files are copied to your computer. When installation is complete, the
Level Registration screen displays.

Macintosh Stand-Alone Installation 20 Copyright © 2004—2006 Read Naturally, Inc.
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9 In the Level Registration window, enter the license numbers for the levels you
purchased. For each license, enter the two-part license number in the boxes and
click Add License. The licenses are added to the list.

10 After you have added all of your licenses, click Next. The Installation Complete
screen displays.

11 Click Done.

12 A dialog asks if you want to run Read Naturally SE now (so you can start setting up
your data).

m  Click No to end the installation process without starting SE.
m  Click Yes to display the SE login window.

For information about setting up your data, see Chapter 6.
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Adding Levels for Macintosh Stand-Alone Installations

If you have already installed Read Naturally SE but you need to add levels (for
example, you may have purchased more levels), you can add the new levels without
having to re-install the software.

To add levels for a Macintosh stand-alone installation:
1 Login to Read Naturally SE with the administrator password.
2 Choose the School tab.

3 From the File menu, choose Register Levels. The Level Registration window
displays.

4 Enter the license numbers for each level you are adding. For each license, enter the
two-part license number in the boxes and click Add License. The licenses are added
to the table.

5 After you have added all of your licenses, click Next. The Installation Complete
screen displays.

6 To add more levels, click Back and repeat steps 4 and 5. If you are finished adding
levels, click Done.

Macintosh Stand-Alone Installation 22 Copyright © 2004—2006 Read Naturally, Inc.
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n Windows Network Installation

This chapter explains how to install Read Naturally SE 2.0 software in a network
environment that includes Windows clients and servers. During the installation
process, you perform the following tasks:

1 Install the SE server components.
Read the license agreement.
b  Specify the location where the software will be installed.
¢ Copy the SE server components on the server's hard drive.
d Enter the license numbers for the levels you purchased.
e Confirm the IP address of the server.
2 Copy the story files from the level CDs to the server.
3 Install the SE client software on each client workstation.
4  Start setting up your school, teacher, class, and student data.

This chapter also includes a procedure for adding levels when Read Naturally SE is
already installed.
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What's Installed

During a network installation, some files are installed on the server and some files are
installed on each client workstation.

SE Server Files

When you install the SE server components on a Windows server, the installer creates a
RNSEServer folder in the Program Files folder on the server's hard drive and copies the
following folders to it:

m  RNSE Client Install folder: Contains the files for installing the SE client software
to the Mac OS and Windows client workstations.

m  RNSEServer folder: Contains files for storing teacher, class, and student information
plus license files for the levels you are authorized to use. When you copy levels to
the server, the story files are also copied here.

SE Client Files

When you install the SE client software on Windows workstations, the installer creates a
Read Naturally SE 2 folder in the Program Files folder on each workstation's hard drive
and copies the following files to it:

Application Files

®  The Teacher Management component
®  The Student Stories component

m A placement program

®  Reporting software

®  Online help files

®  Other supporting programs and files

Data Files
m  Audio files for the stories

m  Text and image files for the placement program

All of these files are installed automatically during the installation process.

Preferences File

A file that stores the IP address of the server and the path to the SE applications on the
local workstation is stored in either the \Windows\Read Naturally\ folder (Windows
98SE and ME clients) or the \Documents and Settings\All Users\Application Data\
Read Naturally folder (Windows XP and 2000 clients).

Windows Network Installation 24 Copyright © 2004—2006 Read Naturally, Inc.
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Installing the Windows Server Components

During the server installation process, you read the license agreement and start the
installation of the server components. The installer sets up a database for storing
student, teacher, and class data and copies files for the client installations to the server.

After the server components are installed, you enter the license numbers for the levels
you purchased and confirm the IP address of the server. (The server must have a static
IP address.) The client workstations must be configured with the server's IP address in
order to access the server. (This happens automatically if you use the client installers
that are installed on the server.)

Before you begin installing the server software, you should close all other applications,
especially virus-protection software, which can interfere with the installation process.

To the install the SE server components:
1 Insert the Network Software Installation CD in the CD drive of the server.

2 If the installation menu doesn't open automatically, double-click the My Computer
icon on the desktop, double-click the RNSE2 InstallNet icon for the CD drive, and
then double-click Menu.exe.

3 Click Install Windows Server Software. The initial setup screen displays.

4 Click Next. The Welcome screen displays.
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5 Click Next. The Software License Agreement displays.

6 Click Yes to accept the terms of the license agreement. (You must accept the terms
in order to install the Read Naturally software.) The Choose Destination Location
screen displays.
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7 By default, Read Naturally SE is installed in the Program Files folder of your hard
drive (C:). In most cases, you should leave the installation location set to the default
and just click Next. (If you need to change the location, click Browse, and choose
the folder where you want to install the Read Naturally software.) The Ready to
Install screen displays.

8 Click Next. The SE server software is installed on the computer. When installation
is complete, the Level Registration screen displays.

9 In the Level Registration window, enter the license numbers for the levels you
purchased. For each license, enter the two-part license number in the boxes and
click Add License. The licenses are added to the list.

10 After you have added all of your licenses, click Next.
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11 A dialog shows the IP address that Read Naturally SE detected for the server. (The
server must have a static IP address.) The client workstations will use this IP address
to connect to the Read Naturally server components. Make sure this address is
correct, and then click OK.

Note: To prevent the firewall in Windows XP from blocking the SE client's access
to the SE server, you must either turn off the firewall or open port 23451 if you
want to leave the firewall running. For more information, see the Read Naturally
website: www.readnaturally.com/support/notes-se2-firewall.htm

12 A message displays telling you that you must copy the levels to the server. Click
OK. The Installation Complete screen displays.

13 Click Done.

14 A dialog asks if you would like to copy the stories to the server at this time. Click
Yes. The Finished screen displays.
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15 Click Close, and continue with the next procedure to copy the stories to the server.
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Copying Stories to the Windows Server

With network installations, you copy the stories from the level CDs to the server's hard
drive. This enables students to access the stories from any client workstation that has
Read Naturally SE 2.0 installed and can access the server.

To copy stories from the level CDs to the Windows server:
1 Insert the first level CD into the CD drive of the server.

2 You can start copying the stories in either of the following ways:

m By clicking Yes at the end of the server installation process, when asked if you
want to copy the story files.

® By double-clicking the FileCopy.exe icon in the \Program Files\RNSEServer\
RNSEServer folder on the server's hard drive.

3 Copy From: The file-copy program should automatically locate the folder on the
CD that contains the stories. If it doesn't, you can click the Browse button and then
locate and select the \StoryFiles\<level>\ folder on the CD and click OK.

4 Copy To: In most cases, you should not change the location where the story files
will be copied. If for some reason you need to change it, you can click the Browse
button and then choose a new location and click OK.

5 Click Copy to start copying the stories to the server.

6 When the copying is finished, a message tells you that the level was copied
successfully. Click OK.

7 To copy additional stories to the server, insert a new level CD into the CD drive of
the server and repeat the process.

8 Click Exit when you are done copying levels.
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To manually copy the stories from the level CDs to the Windows server (if you have
problems with the FileCopy program):

1 Insert a level CD into the CD drive of the server.
2 Browse to the \StoryFiles\<level>\ folder on the CD.

3 Copy the <level>.vdb file to the \Program Files\RNSEServer\RNSEServer\
Databases folder on the server.

Installing the Windows Workstation Software

With a network installation, the data and stories are stored centrally on the server, but
the applications themselves are stored on each client workstation.

Before you begin installing the client software, you should close all other applications,

especially virus-protection software, which can interfere with the installation process.

To install the SE client software on a Windows workstation:
1 Open the \RNSEServer\RNSE Client Install folder on the file server.

2 If a window opens asking for the IP address of the server, enter it and click OK.

3 Double-click the InstallWkstn Win.exe icon. The initial setup screen displays.

Note: If you have problems installing the workstation software from the server (for
example, if the installation is too slow), you can also install the workstation
software by launching InstallWkstn_Win.exe from the SE network installation
CD or from another CD that has the RNSE_Client_Install folder copied to it.

4 Click Next. The Welcome screen displays.
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4 Click Next. The Software License Agreement displays.

5 Click Yes to accept the terms of the license agreement. (You must accept the terms
in order to install the Read Naturally software.) The Choose Destination Location
screen displays.
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6 By default, the SE workstation software is installed in the Program Files folder of
your hard drive (C:). In most cases, you should leave the installation location set to
the default and just click Next. (If you need to change the location, click Browse,
choose the folder where you want to install the Read Naturally software.) The
Ready to Install screen displays.

7 Click Next. A message tells you it is normal if the progress bar seems to stop during
the installation process.

8 Click OK. The installation process begins. (Installation may take several minutes.)
When installation is complete, the Finished screen displays.

7 If you want to start using SE right away, leave the checkbox checked and then click
Close. Otherwise, uncheck the box before you click Close.

For information about setting up your data, see Chapter 6.
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Adding Levels for Windows Network Installations

If you have already installed Read Naturally SE but you need to add levels (for
example, you may have purchased more levels), you can add the new levels without
having to re-install the software.

To add levels from a client workstation:
1 Login to Read Naturally SE with the administrator password.
2 Choose the School tab.

3 From the File menu, choose Register Levels. The Level Registration window
displays.

4 Enter the license numbers for the levels you are adding. For each license, enter the
two-part license number in the boxes and click Add License. The licenses are added
to the table.

5 After you have added all of your licenses, click Next. The Installation Complete
screen displays.
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6 To add more levels, click Back and repeat steps 4 and 5. If you are finished adding
levels, click Done.

7 Copy the stories to the server as described earlier in this chapter.

To add levels from the server:
1 Log in to the server.

2 Browse to the \Program Files\RNSEServer\RNSEServer\ folder and double-click the
InstallLicense.exe file. The Level Registration window displays.

3 Continue with steps 4 through 7 above.
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E Macintosh Network Installation

This chapter explains how to install Read Naturally SE 2.0 software in a network
environment that includes Macintosh clients and servers. During the installation process,
you perform the following tasks:

1 Install the SE server components.
Read the license agreement.
b Copy the SE server components to the server's hard drive.
¢ Enter the license numbers for the levels you purchased.
d Confirm the IP address of the server.
2 Copy the story files from the level CDs to the server.
3 Install the SE client software on each client workstation.
4  Start setting up your school, teacher, class, and student data.

This chapter also includes a procedure for adding levels when Read Naturally SE is
already installed.
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What's Installed

During a network installation, some files are installed on the server and some files are
installed on each client workstation. All of these files are installed automatically during
the installation process.

SE Server Files

When you install the SE server components on Mac OS X servers, the installer creates
the following folders on the server's hard drive:

Applications/RNSEServer/

Contains the files for installing the SE client software on the Mac OS and Windows
client workstations.

Library/RNSEServer/

Contains files for storing teacher, class, and student information plus license files for the
levels you are authorized to use. When you copy levels to the server, the story files are
also copied here.

Library/Preferences/ReadNaturally/

Contains a file that stores the location of the client installers.

Library/Startupltems/RNSEServer/

Contains a shortcut that starts the SE server process whenever you start up the Mac OS
X server.
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SE Client Files

When you install the SE client software on Mac OS workstations, the installer creates

the following folders on each workstation's hard drive:

Applications/Read Naturally SE 2/

Contains the following application and data files:

The Teacher Management component

The Student Stories component

Audio files for the stories

A placement program

Text and image files for the placement program
Reporting software

Online help files

Other supporting programs

Library/Preferences/ReadNaturally/

Contains a file that stores the IP address of the server and the path to the SE software on
the local workstation.
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Installing the Mac OS X Server Components

During the server installation process, you read the license agreement and start the
installation of the server components. The installer sets up a database for storing
student, teacher, and class data and copies files for the client installations to the server.

After the server components are installed, you enter the license numbers for the levels
you purchased and confirm the IP address of the server. (The server must have a static
IP address.) The client workstations must be configured with the server's IP address in
order to access the server. (This happens automatically if you use the client installers
that are installed on the server.)

Before you begin installing the server software, you should close all other applications,
especially virus-protection software, which can interfere with the installation process.

To install the Mac OS X server components:
1 Insert the Network Software Installation CD into the computer's CD drive.

2 When the CD icon RNSE2_InstallNet appears on the desktop, double-click it. A
window opens showing the contents of the CD.

3 Double-click the Menu icon. The installation menu opens.

4 Click Install Mac OS X Server Software. If necessary, enter your Mac OS
administrator name and password and click OK so that you are allowed to install
the software. The Introduction screen displays.

5 Click Continue. The Software License Agreement displays.
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6 Read the license agreement and click Continue. A dialog asks if you agree to the
terms of the license agreement.

7 Click Agree to accept the terms of the license agreement. (You must accept the
terms in order to install the Read Naturally software.) The Installation Type screen
displays.

8 Leave the installation type as Easy Install and click Continue. The installation
process begins. Installation could take several minutes as the files are copied to the
server. When installation is complete, the Level Registration screen displays.
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9 In the Level Registration window, enter the license numbers for the levels you
purchased. For each license, enter the two-part license number in the boxes and
click Add License. The licenses are added to the list.

10 After you have added all of your licenses, click Next.

11 A dialog shows the IP address that Read Naturally SE detected for the server (The
server must have a static IP address.) The client workstations will use this IP
address to connect to the Read Naturally server components. Make sure this address
is correct, and then click OK.

12 A message tells you that you must still copy the story files to the server. Click OK
to close the dialog. The Installation Complete screen displays.
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13 Click Done. The Finish Up screen displays.

14 A dialog asks if you would like to copy the stories to the server at this time. Click
Yes, and continue with the next procedure.
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Copying Stories to the Mac OS X Server

With network installations, you copy the stories from the level CDs to the server's hard
drive. This enables students to access the stories from any client workstation that has
Student Stories installed and can access the server.

To copy stories from the level CDs to the Mac OS X server:
1 Insert the first level CD into the CD drive of the server.
2 You can start copying the stories in either of the following ways:

m By clicking Yes at the end of the server installation process, when asked if you
want to copy the story files.

® By double-clicking the FileCopy icon in the /Library/RNSEServer folder on
the server's hard drive.

3 Copy From: The file-copy program should automatically locate the folder on the
CD that contains the stories. If it doesn't, you can click the Browse button and then
locate and select the /StoryFiles/<level>/ folder on the CD and click Choose.

4 Copy To: In most cases, you should not change the location where the story files
will be copied. If for some reason you need to change it, you can click the Browse
button and then choose a new location and click Choose.

5 Click Copy to start copying the stories to the server.

6 When the copying is finished, a message tells you the level was copied successfully.
Click OK.

7 To copy additional stories to the server, insert a new level CD into the CD drive of
the server and repeat the process.

8 Click Exit when you are done copying levels.
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To manually copy the stories from the level CDs to the Mac OS X server (if you
have problems with the FileCopy program):

1 Insert a level CD into the CD drive of the server.

2 When the rnse2cd icon appears on the desktop, double-click it to open it.
3 Open the StoryFiles folder, and then open the <level> folder.
4

Copy the <level>.vdb file to the /Library/RNSEServer/Databases folder on the
hard drive of the server.

Installing the Macintosh Workstation Software

With a network installation, the data and stories are stored centrally on the server, but
the applications themselves are stored on each client workstation.
Before you begin installing the client software, you should close all other applications,
especially virus-protection software, which can interfere with the installation process.
To install SE client software on a Macintosh workstation:
1 Open the /Applications/RNSEServer/RNSE _Client Install folder on the file server.
2 Double-click the Read Naturally install program for the Mac OS you are using:

®  [fyou are running Mac OS 9, double-click the InstallWkstn_Mac-9 icon.

m  If you are running Mac OS X, double-click the InstallWkstn_Mac-X icon.

3 Ifnecessary, enter your Mac OS administrator name and password so that you are
allowed to install the software. The Introduction screen displays.
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Note: If you have problems installing the workstation software from the server (for
example, if the installation is too slow), you can also install the workstation
software by launching InstallWkstn_Mac-9 or InstallWkstn_Mac-X from
the SE network installation CD or from another CD that has the
RNSE_Client_Install folder copied to it.

4 Click Continue. The Software License Agreement displays.

5 You must accept the terms of the license agreement in order to install the Read
Naturally software.

B In Mac OS 9, click Agree.

B In Mac OS X, click Continue. A dialog asks if you agree to the terms of the
license agreement. Click Agree.

The Installation Type screen displays.
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6 Leave the installation type as Easy Install and click Install. A message tells you it
is normal if the progress bar appears to stop during the installation.

7 Click OK. The installation process begins. Installation could take several minutes as
the files are copied to the workstation.

8 When installation is complete, a dialog asks if you want to run Read Naturally SE
now (so you can start setting up your data).

®  Click No to end the installation process without starting SE.
m  Click Yes to display the SE login window.

For information about setting up your data, see Chapter 6.
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Adding Levels for Macintosh Network Installations

If you have already installed Read Naturally SE but you need to add levels (for
example, you may have purchased more levels), you can add the new levels without
having to re-install the software.

To add levels from a client workstation:
1 Log in to Read Naturally SE with the administrator password.
2 Choose the School tab.

3 From the File menu, choose Register Levels. The Level Registration window
displays.

4 Enter the license numbers for each level you are adding. For each license, enter the
two-part license number in the boxes and click Add License. The licenses are added
to the table.

5 After you have added all of your licenses, click Next. The Installation Complete
screen displays.

6 To add more levels, click Back and repeat steps 4 and 5. If you are finished adding
levels, click Done.

7 Copy the stories to the server as described earlier in this chapter.

To add levels from the server:

1 Log in to the server.

2 Browse to the /Library/RNSEServer/ folder, and double-click the InstallLicense
file. The Level Registration window displays.

3 Continue with steps 4 through 7 above.
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Setting Up Read Naturally SE
for the First Time

It is generally a good idea to designate one person as the Read Naturally administrator
for the entire school, with another person as a backup in case the primary administrator
is not available.

When you initially install Read Naturally SE, the administrator should set up the
following information in Teacher Management, as explained in this chapter:

m  School information

B Administrator password

®  The teachers who will be using Read Naturally SE

Either the administrator or teachers can then set up the following information:
m  The classes assigned to the teachers

m  The students who will be using Student Stories

Teachers can set up and maintain only their own classes and students, whereas the
administrator can set up and maintain all students, classes, and teachers. Only the

administrator can perform certain tasks, such as changing school information and

the administrator password and deleting teachers.
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Logging In for the First Time

The first time you log in to Read Naturally, you must log in using a default password.
Once you set up an administrator password, the default password no longer works.

To log in to Read Naturally SE the first time:

1 Double-click the Read Naturally SE 2.0 icon on your desktop.

The login screen displays.

2 Type rnse as your administrator password and click Enter. Teacher Management
opens to the School tab.

3 Continue by setting up school and administrator information as described on the
next page.
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Setting Up School and Administrator Information

After logging in with the default administrator password, the first thing you must do is
set up a new administrator password and enter information about the school. Only one
administrator password is allowed.

To set up school and administrator information:

1 From the School tab of Teacher Management, specify the following information:

Type the name of the school.

Type the name or number of the school district or school
system.

G I N ESYI B Type the new password you want to use when logging in to
Teacher Management as an administrator. Think of a
password that is easy for you to remember but difficult for
others to guess. Passwords with both letters and numbers
are harder to guess.

m  All passwords must be unique. No two people can have
the same password.

Passwords must be 4 to 20 characters long.
Passwords are case sensitive.

m  Make sure there are no leading or trailing spaces in the
password.

B You must change the administrator password from rnse
(the default) to something else.

Be sure to safeguard the administrator password, since
administrators are able to view and change settings for all
students, teachers, and classes.

Also, be sure to remember the administrator password,
since others cannot log in to look it up for you.

Note: If you lose or forget the administrator password, see
“Looking Up the SE Administrator Password” in Chapter 7.

2 Click Save.

3 Continue by adding teachers as described on the next page.
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Adding Teachers

Only the administrator can add and delete teachers. Once they are added, teachers can
change their own names and passwords as necessary.

To add teachers:

1 After logging in as an administrator, select the Teachers tab.
2 For each teacher you want to add, perform the following steps:
Click Add.
b Enter the teacher's first and last name.
¢ Specify the password that the teacher will use to log in to Teacher Management.

®  Think of a password that is easy to remember but difficult for others to
guess. Passwords with both letters and numbers in them are harder for
people to guess.

m  Passwords must be 3 to 14 characters long.
m  Passwords are case sensitive. jdoe and JDoe are different passwords.

d If you check the Teacher Assistant box, this person will only be able to pass
students on stories. (They will not be able to log in to Teacher Management
or change story options. Teacher Assistants cannot have classes or students
assigned to them.)

e Click Save.

3 When you are finished adding teachers, continue by adding classes as described on
the next page.
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Adding Classes

When you set up a class, you give the class a name and assign a teacher to it. You can
only assign teachers that are already in the system, so make sure you have added the
teachers before you add the classes.

To add classes:

1 After logging in as an administrator or teacher, select the Class tab.
2 For each class you want to add, perform the following steps:
Click Add.
b Type the name of the class.

¢ Select a teacher from the drop-down list to assign him or her to the class.

Note: If you log in as a teacher, you do not need to select a teacher, since you can only
add your own classes.

d Click Save.

3 When you finished adding classes, continue by adding students as described on the
next page.
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Setting Up and Placing Students

Setting up students involves three tasks:
®  Adding students by specifying identification and profile information.

m  Placing students in the appropriate level and goal by testing them with sample
stories.

m  Setting up story options for each student.

Adding Students

When you add a student, the first step is to enter identification and profile information,
such as the student's name, ID, password, grade, class, teacher, and characteristics. You
can only assign students to teachers and classes that are already in the system, so make
sure you have added the teachers and classes before you add the students.

To add students:
1 After logging in as an administrator or teacher, select the Students tab.
2 Click Add.
3 Complete the following required information (blue headings):
m  First Name/Last Name
m  Grade

m  Password: This is what the student will enter when logging in. Passwords must
be 3 to 14 characters long.

m  Teacher: Choose one from the list. (If you log in as a teacher, no selection is
necessary, since all of the students you add are assigned to you.)

m  Class: Choose one from the list. (Only the classes assigned to the current
teacher are available.)

4 You can also provide the following optional information:
m  Student ID
®  Demographics (gender and type of student)

5 Click Save.

6 Click Yes if you want to set up story options for this student right away or click
No if you want to set them up later. (See the SE Teacher's Guide for detailed
descriptions of the story options.)

Setting Up Read Naturally SE for the First Time 54 Copyright © 2004—2006 Read Naturally, Inc.
SE Software Guide



Setting Up Story Options for Students

In the story options, you customize the Read Naturally process for each student.
This is where you can adjust each student's level and goal, specify which steps are
included, and tailor the behavior of the program to suit each student's needs.

To set up story options:

1
2
3

After logging in as an administrator or teacher, select the Students tab.
Choose a student, and then click Story Options.

Change the story options as necessary. Click the Advanced tab for more options. For
detailed descriptions of the options, see the SE Teacher's Guide.

Click Save.

Placing Students

Teacher Management includes a placement program which automates the process
of placing students at an appropriate instructional level and reading-rate goal. The
placement program's recommendations are only guidelines. Select the goals and
levels that are best suited for your students.

For a more detailed discussion of placing students, see the SE Teacher's Guide.

To place students using the SE placement program:

1 After logging in as an administrator or teacher, select the Students tab.

2 Select the student you want to place and then click Place.

3 Estimate the instructional level that this student is currently reading at. Select a
story that is at or close to the student's estimated instructional level, and then click
Next.

4 Turn the Reading Guide on if necessary, and click Start when the student is ready
to start reading.

5 As the student reads aloud, listen and silently count the number of errors (see the SE
Teacher's Guide for guidelines for counting errors).

6 When the bell sounds, click the last word the student read.

7 Enter the number of words the student missed, and then click Next. The placement
program will either recommend a level and goal or recommend testing the student
with another story.

8 Either click OK to accept the recommendation or click New Story to test the
student with another story. You can also click Change if you want to override
the recommendation or skip further testing.

Copyright © 2004—2006 Read Naturally, Inc. 55 Setting Up Read Naturally SE for the First Time

SE Software Guide



Setting Up Read Naturally SE for the First Time 56 Copyright © 2004—2006 Read Naturally, Inc.
SE Software Guide



ﬂ Administering Read Naturally SE

This chapter describes the following tasks for administering Read Naturally SE:
®  Changing school information and the administrator password.
m  Searching the teacher, class, and student lists.

B Maintaining teacher, class, and student information.

m  Specifying the server IP address for network clients.

m  Starting and exiting the database utilities.

m  Checking the login status for network installations.

m  Resetting logged in users.

m  Looking up the administrator password.

®  Importing SE 1.x data into SE 2.0.

m  Starting and stopping the RNSEServer service.

m  Backing up and restoring the data files.

m Restoring an empty database.

m  Repairing the database.

The following table compares the information that the administrator can change versus
the information that teachers can change:

Information Type Administrator

School information Can set up and change Cannot view nor change
school information and the school information or the
administrator password. administrator password.

Teacher information  Can add, edit, and delete Can change only their own
any teachers. name and password.

Class information Can add, edit, and delete Can add, edit, and delete only
any classes. their own classes.

Student information ~ Can add, edit, and delete Can add, edit, and delete only
any students. their own students.
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Changing School and Administrator Information
Only the administrator can change school information and the administrator password.

To change school and administrator information:

1 Log in with the Read Naturally administrator password.
2 Choose the School tab.
3 Change the school name, district name, and administrator password as necessary.

4 Click Save.

Searching the Teacher, Class, and Student Lists

Teacher Management has sort and search features to help you find teachers, students,
and classes.

To sort a list Click a column heading to sort by that column.

To search a list Click the heading of the column you want to search.

Type the text you want to search for.

Click Find. The list shows the items that match your search.
Click Show All to see the complete list again.
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Maintaining Teacher Information

The administrator can add, edit, and delete teachers. Teachers can only change their own
name and password.

To maintain teacher information:

1 Log in with a Read Naturally administrator or teacher password.
2 Choose the Teachers tab.
3 Ifyou logged in as a teacher, change your name or password as necessary and then
click Save.
If you logged in as the administrator, you can perform any of the following actions:
Add a teacher a Click Add.

Enter the teacher's first and last name.

Specify the password that the teacher will use to log in to

Teacher Management.

B Think of a password that is easy to remember but
difficult for others to guess. Passwords with both
letters and numbers in them are harder for people
to guess.

B Passwords are case sensitive. jdoe and JDoe are
different passwords.

d If you check the Teacher Assistant box, this person will
only be able to pass students on stories. (They will not
be able to log in to Teacher Management or change story
options. Teacher Assistants cannot have classes or
students assigned to them.)

e Click Save.

Edit a teacher a Choose the teacher you want to edit.

b Click Edit.

¢ Change the teacher information as necessary.

d Click Save.

DECICRERCEG T @  Choose the teacher you want to delete.

b Click Delete.

¢ Click Yes to confirm.

Note: You cannot delete teachers with classes or students

assigned to them.
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Maintaining Class Information

The administrator can add, edit, and delete classes assigned to any teachers. Teachers
can add, edit, and delete only their own classes.

To maintain class information:

1 Log in with an administrator or teacher password.
2 Choose the Classes tab.

3 Perform any of the following actions:

Add a class a Click Add.
Specify a class name.

Administrators must select a teacher from the drop-down
list to assign the class to him or her. When teachers add
classes, the classes are automatically assigned to them.

Click Save.

Choose the class you want to edit.
Click Edit.

Edit the class as necessary. Teachers can only change
the name of the class. Administrators can also change
the teacher assigned to the class.

0O T 9 Q

d Click Save.
Delete a class a Choose the class you want to delete.
b Click Delete.

¢ Click Yes to confirm.

Note: You cannot delete classes with students assigned to
them.
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Maintaining Student Information

The administrator can add, edit, and delete students assigned to any teachers. Teachers
can add, edit, and delete only their own students. See the Chapter 6 and the SE Teacher's
Guide for information about placing students and setting story options.

To maintain student information:

1 Log in with an SE administrator or teacher password.

2 Choose the Students tab.

3 Perform any of the following actions:

Add a student a Click Add.

b Complete the following required information (blue

headings):

m  First Name/Last Name

m  Grade

m Password: This is what the student will enter when
logging on. Passwords are case-sensitive and must
be 3 to 14 characters long.

m Teacher: Administrators must choose one from the
list. For teachers, no selection is necessary, since
all of the students you add are assigned to you.

m Class: Choose a class for the student. Only the

classes assigned to the current teacher are
available.

You can also provide the following optional information:

m  Student ID

m  Demographics (gender and type of student)

Click Save.
Edit a student's Either double-click the name of a student or choose the
identification student and then click Edit.

information

Change the student information as necessary.
(Information with blue headings is required.)

Click Save.
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LCE O IERS Ol Note: Only the administrator can assign a student to another
to another teacher.
teacher a Either double-click the name of a student or choose the
student and then click Edit.
Choose a different teacher from the drop-down list.

Choose a class for the student. Only the classes for the
new teacher are listed.

Click Save.

Delete a student

Choose the student you want to delete.
Click Delete.
Click Yes to confirm.

0O T o9 Qa

Specifying the Server IP Address for Network Clients

In network installations, the SE client workstations must be configured with the server's
IP address in order to access the SE server components, such as the story files, student
data, and teacher data.

If you install the client software using the client installers on the server, this IP address
should be set up correctly automatically. However, there are some cases when you may
have to manually specify the server's IP address in the SE client software, such as:

m  If you install the client software from the client installers on the Network Software
Installation CD instead of from the server.

m [f a server has more than one IP address and the installer selected the wrong IP
address during the installation.

m [f the IP address of the server has changed.

To change the server IP address for a client workstation:

1 From the log-in screen, choose Network Settings from the Network menu.
2 Enter the server's IP address, and click Save.

Note: To prevent the firewall in Windows XP or Mac OS X from blocking the SE
client's access to the SE server, you must either turn off the firewall or open port 23451
if you want to leave the firewall running. For more information, see the Read Naturally
website: www.readnaturally.com/support/notes-se2-firewall.htm
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Starting and Exiting the Database Utilities

This procedure explains how to start the SE database utilities on different platforms as
well as how to exit the database utilities. These utilities enable you to perform the
following tasks:

®  View a list of the teachers and students that are currently active in SE.

®  Import SE version 1.x data into SE version 2.0.

®  Backup and restore SE data.

®  Restore an empty database by removing teacher, class, and student data.

m  Repair the SE database so that it runs more efficiently.

Before You Begin...

Before you can use the database utilities, you must have completed the following tasks:

B You must install the SE version 2.0 software as described in this guide. For network
installations, you must install the server components on a server plus the client
software on at least one workstation.

®  You must log in to Teacher Management with the default password (rnse) and set

up the information on the School tab (school name, district name/number, and
administrator password). The administrator password you set up here is the
password you will use to log in to the database utilities.

To start the database utilities:

1

To start the database utilities, double-click the rnse_DBUtilities file. The location of
this file depends upon your operating system and installation type as shown in the
following table:

Installation Type Location of the rnse_DBUtilities Application

Windows stand-alone* \Program Files\Read Naturally SE 2\
Mac OS 9 standalone /Applications (Mac OS 9)/Read Naturally SE 2/
Mac OS X standalone /Applications/Read Naturally SE 2

Windows network \Program Files\RNSEServer\RNSEServer on the server

Mac OS X network /Library/RNSEServer on the server

*On Windows computers, you can also start the database utilities from the Start menu (Start
> (All) Programs > Read Naturally SE 2.0 > Read Naturally Database Utilities).

Enter the Read Naturally administrator password, and click OK.
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Note: You cannot log in to the database utilities with the default password (rnse). You
must set up your own administrator password in SE Teacher Management and
use that password.

3 If you are using a Mac OS X computer as the SE server, you will be prompted for
your system or administrator password. Enter the Mac OS X administrator
password, and click OK.

4 Choose the tab for the task you want to perform.

To exit the database utilities:

Click Quit to close the database utilities window.

Checking the Login Status for Network Installations

If you are using a network installation of Read Naturally SE, the Network Status tab in
the database utilities lists the teachers and students that are currently logged in. This
information can be useful when deciding when it is safe to perform system maintenance,
such as backing up the SE data. It can also help you troubleshoot login problems. If
users are listed as active when they're not logged in, you may have to reset their login
status as described on the next page.

Note: If you are using Mac OS X and you are prompted for an administrator password
while you are using the database utilities, enter your Mac OS X administrator
password, not your Read Naturally administrator password.

To check the login status for network installations of Read Naturally SE:
1 Start the SE database utilities (see page 63).
2 Choose the Network Status tab. This tab lists the active teachers and students.

3 The list on the Network Status tab is just a snapshot of the active teachers and
students. You can click Refresh periodically to view a new snapshot of the active
users.
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Resetting Logged In Users

On occasion, users may attempt to log in and receive a message that says they are
already logged in. This can happen if Read Naturally SE is not properly shut down due
to a power failure or system crash, for example, which prevents SE from clearing the
user records correctly.

The way to remedy this situation is to reset the logged in users. You can reset individual
students, individual teachers, the administrator, or all users. Make sure the users you are
resetting are not actively using the software when you perform the reset.

To reset a logged in student:
1 From the login screen, choose Reset Logged In Student from the Network menu.

2 Enter the following information:

m A teacher password. This ensures that only teachers can reset logged-in
students.

®  The password for the student you want to reset.
3 Click OK. A message tells you the student was reset successfully.
4 Click OK.

To reset a logged in teacher:

1 From the login screen, choose Reset Logged In Teacher from the Network menu.
2 Enter the following information:

®  The Read Naturally administrator password. This ensures that only the
administrator can reset logged-in teachers.

®  The password for the teacher you want to reset.
3 Click OK. A message tells you the teacher was reset successfully.
4 Click OK.
To reset a logged in administrator:
1 From the login screen, choose Reset Admin from the Network menu.

2 Enter the Read Naturally administrator password and click OK. Only the
administrator can reset the administrator login.

3 Click Yes to confirm that you want to reset the administrator login.

4 Click OK.
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To reset all users:
1 From the login screen, choose Reset All from the Network menu.

2 Enter the administrator password and click OK. Only the administrator can reset all
users.

3 Click Yes to confirm that you want to reset all users.

4 Click OK.

Looking Up the SE Administrator Password

If you lose or forget the SE administrator password, there is a utility on the server that
you can use to look it up.

To look up the SE administrator password:

1 Double-click the AdminPassword file on the server. The location of the utility is
different for different types of installations:

Windows servers \Program Files\RNSEServer\RNSEServer

Mac OS X servers /Library/RNSEServer/

SIEN GBI RN S B R Utilities folder on the SE stand-alone installation CD

The administrator password is displayed.

2 Click OK.

Importing SE 1.x Data into SE 2.0

If you are upgrading from version 1.x of Read Naturally SE to version 2.0, you can use
the import utility to move your existing data to the new version, as long as the SE v2.0
database does not include any teachers, classes, or students. In most cases, the utility
imports all of the teacher, class, and student information except for the students' story
options. (You will have to re-enter the story options after importing.) In some cases, the
utility may not be able to import students' class and teacher assignments if there are
problems with the SE 1.x data.

Before You Begin...

Before you can use the database utilities to import SE 1.x data into SE 2.0, you must
have completed the following tasks:

®  Make sure you are running SE 1.5 or higher. If you are running an earlier version
of SE 1.x, please install the free SE v1.6 update from the Read Naturally website
(www.readnaturally.com/support/products-seupdates.htm). To find your SE 1.x
software version, open Student Stories and then select About Read Naturally from
the RN Help Menu.
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®  You must run the SE 1.6 Data Repair Utility. From the SE v1.6 Utilities page
of the Read Naturally website (www.readnaturally.com/support/products-
selutilities.htm), download and install either RNData_RepairMac.sit.bin for
Mac OS or RNData_RepairWIN_dnload.exe for Windows.

Notes:
B You do not need to uninstall Read Naturally SE 1.6

m  If you are using Mac OS X and you are prompted for an administrator password,
enter your Mac OS X administrator password, not your Read Naturally
administrator password.

To import SE 1.x data into SE 2.0:

1 Before importing the SE 1.6 data into SE 2.0, manually back up the Read Naturally
SE 1.6 Data folder to another location. The location of the SE 1.6 Data folder varies
by operating system and installation type as follows:

Installation Type Location of the Data Folder

Windows stand-alone  \Program Files\Read Naturally
Mac OS 9 stand-alone /Applications (Mac OS 9)/Read Naturally
Mac OS X stand-alone /Applications/Read Naturally

Windows network \<shared-folder-name>\RN Server on the server
Mac OS X network /Applications/<shared-folder-name>/RN Server on the
server

2 Start the SE database utilities (see page 63).

3 In order to import SE 1.6 data into SE 2.0, the SE 2.0 database must not contain any
teachers, classes, or students. The import process does not affect the information on
the School tab in SE 2.0 Teacher Management (school name, district name/number,
and administrator password).

If the SE 2.0 database does contain teachers, classes, or students, you can remove
them by restoring an empty database. For more information, refer to "Restoring an
Empty Database" later in this section.

4 To import SE 1.6 data into SE 2.0, perform these steps:
a Click the Import Data tab, and then click the Import Data button.
b Click the Select data folder button.
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¢ Locate the folder containing your SE version 1.6 data. The following table
indicates where the Data folder is located for different types of installations:

For this type of installation... | The Data folder is generally in this location:

Windows stand-alone \Program Files\Read Naturally\Data\
Mac OS 9 stand-alone /Applications (Mac OS 9)/Read Naturally/Data
Network (all platforms) \RNSEServer\Data\ on the server

d Select the Data folder and click OK (Windows) or Choose (Mac).
e Click Import Data.

Note: Read Naturally SE automatically creates a backup file of the current data before
importing the new data. That way you can restore the original data if there is a
problem during the import.

f Specify a location (folder) for the backup file and click OK.
g When the backup is finished, click OK.
h  When the import is finished, click OK.

5 The students' Level and Goal fields in Story Options will be blank in Read Naturally
2.0 after you have imported the Read Naturally SE 1.6 data. You can print a Levels
Report that lists the students' current levels and goals in SE 1.6, which you will then
need to enter into SE 2.0. To print an SE v1.6 Levels Report, perform these steps:

a Log into the SE 1.6 Teacher Management program.
b Select Teachers.

¢ Click the Scores and Reports button.

d Choose the Level Report.

You will need to perform these steps for each teacher.
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Starting and Stopping the RNSEServer Service

To resolve certain kinds of issues in network installations, it may be necessary to stop
and then restart the main SE server component, RNSEServer. The latest version of SE
(version 2.0.3) includes a utility for starting and stopping the the RNSEServer service.
You should only stop the RNSEServer service when no one is using the SE software.

To start and stop the RNSEServer service:

1 Double-click the ServerStartStop file on the server. The location of the utility is
different for Windows and Mac OS X servers:

\Program Files\ RNSEServer\RNSEServer\
[ ETNO R QT1A-I Ml /Library/RNSEServer/

2 To stop the RNSEServer service, click Stop Server.

3 To restart the RNSEServer service, click Start Server.
4 Click Quit to close the utility.

Backing Up and Restoring the Data Files

Read Naturally recommends backing up your Read Naturally SE data files

every day. The data files contain all the information you've entered in the Teacher
Management application and detailed information about each student's progress in
the Student Stories application. You can use the backup to restore your data files
if they ever become lost or damaged.

Note: In order to be able to recover data in the event of a hard drive failure, you
should save the backup file to a tape, CD, or other media. For additional safety,
you should periodically save at least one backup copy at an off-site location.

The easiest way to back up and restore data is with the SE database utilities. However,
you can also back up and restore data manually.

To back up the SE 2.0 data using the SE database utilities:
1 Start the SE database utilities (see page 63).

2 From the Backup/Restore tab, click Create Backup.

3 Click Continue.
4

Browse to the folder where you want to store the backup file. Select the folder and
click OK (Windows) or Choose (Mac).
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5 If you are using a Mac OS X computer as the SE server, you will be prompted for
your system password. Enter the Mac OS X administrator password and click OK.

6 When the backup is finished, click OK.

Note: The name of the backup file is based on the date and time it was created. For
example, the backup file rn-82306_145258.rnb was created on Aug. 23, 2006
at 2:52:58 p.m.

To restore the SE 2.0 data from a backup using the SE database utilities:
1 Start the SE database utilities (see page 63).

2 From the Backup/Restore tab, click Restore Backup.
3 Click Continue.
4

Locate the backup file you want to use to restore the data. Select the file, and click
OK (Windows) or Open (Mac).

5 When the data is restored, click OK.

To manually back up the SE 2.0 data files:

1 Make sure everyone (administrators, teachers, and students) is logged out of Read
Naturally SE. No SE application processes can be active when you back up the data
files.

2 For Windows network installations only, you must stop the RNSEServer process.
The easiest way to do this is to use the ServerStartStop utility included with SE
(see “Starting and Stopping the RNSEServer Service” in this chapter for details).

3 Copy the following files to a backup location, such as a CD or tape:

Stand-Alone Installations Network Installations

rn.dat master.vdb
rn.vdb rn.dat
rn.ind rn.vdb
rn.ind
Administering Read Naturally SE 70 Copyright © 2004—2006 Read Naturally, Inc.

SE Software Guide



The table below indicates where these files are located for each of the installation
types and platforms.

Installation Type Data File Location

Windows On the workstation's hard drive (usually C:) in the following
stand-alone folder:

installations \Program Files\Read Naturally SE 2\Data\

Mac OS 9 On the workstation's hard drive in the following folder:
stand-alone /Applications (Mac OS 9)/Read Naturally SE 2/Data/
installations

Mac OS X On the workstation's hard drive in the following folder:
stand-alone /Applications/Read Naturally SE 2/Data/

installations

Windows network On the server's hard drive in the following location:

installations \Program Files\RNSEServer\RNSEServer\Databases\
Macintosh On the server's hard drive in the following location:
network /Library/RNSEServer/Databases/

installations

4 For Windows network installations only, restart the RNSE Server process. The
easiest way to do this is to use the ServerStartStop utility included with SE
(see “Starting and Stopping the RNSEServer Service” in this chapter for details).

To manually restore the SE 2.0 data files from a backup:

1 Make sure everyone (administrators, teachers, and students) is logged out of Read

Naturally SE. No SE application processes can be active when you restore the data
files.

2 For Windows network installations only, you must stop the RNSEServer process.
The easiest way to do this is to use the ServerStartStop utility included with SE
(see “Starting and Stopping the RNSEServer Service” in this chapter for details).
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3 Copy the following files to their original locations, overwriting the current files:

Stand-Alone Installations Network Installations

rn.dat master.vdb

rn.vdb rn.dat

rn.ind rn.vdb
rn.ind

See the table on the previous page for the locations to copy these files to for
different types of installations.

4 For Windows network installations only, restart the RNSE Server process. The
easiest way to do this is to use the ServerStartStop utility included with SE
(see “Starting and Stopping the RNSEServer Service” in this chapter for details).

Restoring an Empty Database

There are times when it may be useful to clear all teacher and student data from Read
Naturally SE. For example, at the beginning of a new school year, it may be easier
to start with a clean slate rather than try to make changes to the previous year's data.

This procedure explains how to restore Read Naturally SE to an empty database, that is,
without teacher, class, and student data. This operation does not affect any information
on the School tab (school name, district name/number, administrator password).

Note: If you are using Mac OS X and you are prompted for an administrator password
while you are using the database utilities, enter your Mac OS X administrator
password, not your Read Naturally administrator password.

To restore an empty database:
1 Start the SE database utilities (see page 63).

2 From the Backup/Restore tab, click Restore Empty DB.
3 Click Continue.
4

Browse to the folder where you want to store a backup of the database before it is
cleared. Select the folder, and click OK (Windows) or Choose (Mac).

When the backup is finished, click OK.
6 When the database is cleared, click OK.

W
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Repairing the Database

The data repair utility cleans up the database so that it is more compact and runs more
efficiently. It can also fix some database-related problems. It is recommended that you
run the data repair utility once a year or so.

Note: If you are using Mac OS X and you are prompted for an administrator password
while you are using the database utilities, enter your Mac OS X administrator
password, not your Read Naturally administrator password.

To run the data repair utility:
1 Start the SE database utilities (see page 63).

2 From the Repair tab, click Repair.
3 Make sure no one is using Read Naturally, and then click Continue.
4

The text box lists the results of the data repair operation.
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E Uninstalling Read Naturally SE

This chapter explains how to uninstall the different types of Read Naturally installations.
For network installations, you must uninstall the client software and server software
separately. This chapter includes the following procedures:

m  Uninstalling SE software from Windows stand-alone and client workstations.
(The procedure is the same for both.)

®  Uninstalling SE server software from Windows servers.
®  Uninstalling SE software from Macintosh stand-alone computers.
®  Uninstalling SE client software from Macintosh workstations.

®  Uninstalling SE server software from Mac OS X servers.
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Uninstalling SE Software from Windows Stand-Alone and
Client Workstations

When you uninstall Read Naturally SE from Windows computers, you use the Add
or Remove Programs utility in the Windows Control Panel. You follow the same
procedure to uninstall stand-alone installations and the Windows client software in
network installations.

To uninstall SE software from Windows stand-alone or client workstations:

1 From the Windows Start menu, choose Control Panel. (If you are running Windows
98SE or 2000, choose Settings > Control Panel from the Start menu.)

2 Double-click Add or Remove Programs.

3 Locate and choose Read Naturally SE 2.0.3 Stand-alone or Read Naturally SE
2.0.3 Client in the list of programs.

4 Click Change/Remove.
5 Click Yes to confirm.

6 When the uninstallation is complete, click OK.

Uninstalling SE Server Software from Windows Servers

When you uninstall Read Naturally SE from Windows computers, you use the Add
or Remove Programs utility in the Windows Control Panel. You must restart the
Windows server to completely uninstall the SE server software.

To uninstall the SE server software from a Windows server:

1 From the Windows Start menu, choose Control Panel. (If you are running Windows
2000, choose Settings > Control Panel from the Start menu.)

2 Double-click Add or Remove Programs.
3 Locate and choose Read Naturally 2.0.3 Server in the list of programs.
4 Click Change/Remove.
5 Click Yes to confirm.
6 When the uninstallation is complete, click Yes to restart the server.
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Uninstalling SE Stand-Alone Software from Macintosh
Workstations

The Mac OS installers you used to install the SE stand-alone software will also uninstall
the SE stand-alone software. You could also uninstall the files manually by deleting the
files that are created during the installation process. (See Chapter 3 for information
about the SE file locations.)

To uninstall an SE stand-alone installation from a Mac OS computer:

1
2

Insert the Stand-Alone Software Installation CD into the computer's CD drive.

When the CD icon RNSE2_Install_SA appears on the desktop, double-click it. A
window opens showing the contents of the CD.

Open the Mac OS installation menu, either Menu_OSX if you use Mac OS X or
Menu_0S9 if you use Mac OS 9.

From the installation menu, click either Install Mac OS X Software or Install Mac
OS 9 Software, depending upon the Mac OS version you are using.

If necessary, enter your Mac OS administrator name and password and click OK so
that you are allowed to uninstall the software. The Introduction screen displays.

6 Click Continue. The Software License Agreement displays.
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7 You must accept the terms of the license agreement in order to uninstall the Read
Naturally software.

B In Mac OS 9, click Agree.

B In Mac OS X, click Continue. A dialog asks if you agree to the terms of the
license agreement. Click Agree.

The Installation Type screen displays.

9 Change the installation type to Uninstall, and click Continue.
10 When the uninstall process is finished, click Quit.
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Uninstalling SE Client Software from Macintosh Workstations

You can use the SE client installers to uninstall the SE client software from Macintosh
computers. You could also uninstall the files manually by deleting the files that are
created during the installation process. (See Chapter 5 for information about the SE file
locations.)

To uninstall the SE client software from a Mac OS workstation:
1 Open the /Applications/RNSEServer/RNSE _Client Install folder on the file server.
2 Double-click the Read Naturally install program for the Mac OS you are using:

®  If you are running Mac OS 9, double-click the InstallWkstn_Mac-9 icon.

m  If you are running Mac OS X, double-click the InstallWkstn_Mac-X icon.

3 Ifnecessary, enter your Mac OS administrator name and password so that you are
allowed to uninstall the software. The Introduction screen displays.

4 Click Continue. The Software License Agreement displays.
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5 You must accept the terms of the license agreement in order to uninstall the Read
Naturally software.

B In Mac OS 9, click Agree.

B In Mac OS X, click Continue. A dialog asks if you agree to the terms of the
license agreement. Click Agree.

The Installation Type screen displays.

6 Change the installation type to Uninstall, and click Uninstall.
7 When the uninstall process is finished, click Quit.
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Uninstalling SE Server Software from Mac OS X Servers

The Mac OS X installer you used to install the SE server software will also uninstall the
SE server software. You could also uninstall the files manually by deleting the files that
are created during the installation process. (See Chapter 5 for information about the SE

file locations.)

To uninstall the SE server software from a Mac OS X server:

1 Insert the Network Software Installation CD into the computer's CD drive.

2 When the CD icon RNSE2_InstallNet appears on the desktop, double-click it. A
window opens showing the contents of the CD.

3 Double-click the Menu icon. The installation menu opens.

4 Click Install Mac OS X Server Software. If necessary, enter your Mac OS
administrator name and password and click OK so that you are allowed to install
the software. The Introduction screen displays.

5 Click Continue. The Software License Agreement displays.
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6 Click Continue. A dialog asks if you agree to the terms of the license agreement.

7 Click Agree to accept the terms of the license agreement. (You must accept the
terms in order to uninstall the Read Naturally software.) The Installation Type
screen displays.

8 Change the installation type to Uninstall, and click Continue.

9 When the uninstall process is complete, click Quit.
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